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Disclaimer and Risk Warnings 

Trading any financial market involves risk. The content of this e-book, its various associated websites 

and all related correspondence are neither a solicitation nor an offer to purchase or sell any financial 

instrument. 

Although every attempt has been made to assure accuracy, we do not give any express or implied 

warranty as to its accuracy. We do not accept any liability for error or omission. Examples are provided 

for illustrative and educational purposes only and should not be construed as investment advice or 

strategy. 

No representation is being made that any account or trader will or is likely to achieve profits or losses 

similar to those discussed in this e-book. Past performance is not indicative of future results. 

By purchasing the software, subscribing to our mailing list or using the website you will be deemed to 

have accepted these terms in full. 

The LeapFX Team, their representatives and associates do not and cannot give investment advice. 

We endeavor to ensure that related websites are available 24 hours per day but we cannot be held 

liable if, for any reason, a site is unavailable. 

The information provided in this e-book is not intended for distribution to, or for use by, any person or 

entity in any jurisdiction or country where such distribution or use would be contrary to law or 

regulation or which would subject us to any registration requirement within such jurisdiction or country. 

There are numerous factors related to the market in general and to the implementation of any specific 

trading program, which cannot be fully accounted for in the future of performance results, all of which 

can adversely affect actual trading results. 

We reserve the right to change these terms and conditions without notice. You can check for updates to 

this disclaimer at any time without notification. 

The content of this e-book and all related websites and correspondence are copyright and may not be 

copied or reproduced. 

Commodity Futures Trading Commission Futures and Options trading has large potential rewards, but 

also large potential risk. You must be aware of the risks and be willing to accept them in order to invest 

in the FOREX, futures and options markets. The past performance of any trading system or methodology 

is not necessarily indicative of future results. 
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Recommendations To Help You Excel 

 

The following recommendations are to help you get the best and most profitable experience from your 

use of this software and trading Forex in general. 

Please consider following these recommendations as we have reviewed them and utilized them for 

years successfully – including other hundreds of other traders we work with. 

 

Which Forex Broker Should You Use? 

Click the link below to go to our Forex broker review page where we explain how we select our brokers 

and which one you should use. 

Click Here for Broker Recommendations  

(ECN Account Recommended) 

After signing up with one of our recommended brokers download and install Meta Trader 4, which is 

provided free by them. 

 

Use A VPS and Everything Will Run Even If Your Computer is Off… 

You can avoid leaving your computer on and access your platform from any mobile device using a virtual 

server. 

Click the link below to learn more about what a VPS is, why we recommend them, and the most reliable 

and affordable options that we recommend. 

Click Here for VPS Recommendations 

 

Want Someone to Install And Setup Arbitron For You? 

Don’t feel like setting up the software or prefer someone else to do it for you?  Not a problem, click the 

link below and have a pro do it for you. 

Click Here to Have a Pro Install Arbitron for You 

 

Don’t Forget to Activate The Software In Members Area 

If you haven’t already, please go back to member’s area and scroll down to the section where you must 

activate Arbitron with your broker MT4 account number. 

This is necessary to allow the software to run on your account.  It can be changed anytime if you choose 

to switch accounts or brokers. 

Click Here To Go To Members Area 

  

https://www.leapfx.com/trusted-forex-brokers/
https://www.leapfx.com/vps-recommendation/
http://www.fxinstall.com/
https://www.leapfx.com/arbitron-members/
https://www.leapfx.com/arbitron-members/
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Support Email: 

 
Email support@leapfx.com if you have any support questions. 

Check list to start trading with Arbitron software: 

1. Arbitron software (MetaTrader EA and Arbitron Feeder) 

2. Activated trading account 

3. Your broker's MetaTrader 4 platform 

4. We recommend Virtual Private Server (VPS) located in the US or UK, whichever is closer to use your 

broker servers (usually US NYC is best).  The VPS host will provide you instructions to connect to the VPS.  

 IMPORTANT: MetaTrader4, Arbitron and Arbitron Feeder must be run on the same computer or VPS 

server. You can run Arbitron software on your PC to try it before active work but you should understand 

the importance of fast and stable connection to the internet and power source. Only a VPS service can 

guarantee stable work of our software. 
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Arbitron Feeder configuration  

For Arbitron feeder to work correctly please make sure you have .net framework 4.7.2 installed.  It’s free 

from Microsoft.  It may already be installed on your computer, but if the software doesn’t work you will 

need it – you can download it here: https://dotnet.microsoft.com/download/dotnet-framework/net472 

Open ArbitronFeeder.exe     click the Options button.     Enter the email address you purchased with, 

enter your receipt you received with your purchase.  And for the  Ip / Port    use one of the following 

listed. 

Europe IP (If your VPS / PC is in EUROPE): 81.171.17.219 

North America IP (If your VPS / PC is North America): 45.43.28.14 

Port (same for both): 41800 

 

Click  Accept , then click Start .  If all is correct, it will look like the following image…

  
 

 

Be attentive to ping level, the lower it is the faster 

you are. We recommend levels under 20ms, but 

can work up to 100ms.

https://dotnet.microsoft.com/download/dotnet-framework/net472


Sharing This Manual or Its Accompanying Software Without Permission Is Strictly Prohibited. 
LeapFX © Copyright 2019, All Rights Reserved. 

Expert Advisor installation  

1. Install MetaTrader platform from your broker 

2. You will need to do the following configuration. At the top of MT4, Click Tools>Options>Expert 

Advisors. Check the same boxes as indicated below, then click Ok: 

 

3. On the top of Meta Trader 4 make sure the AutoTrading is pushed in and GREEN, click it, if it’s RED. 

 

4. To install Arbitron you will need to load the Arbitron.ex4 file into the platform's data folder: At the 

top left of the platform click File>Open Data Folder>MQL4>Experts>And place the Arbitron.exe file 

there.  Then go back to MQL4 folder, and click Presets, and place the files from the Presets folder in 

there. Now restart the MT4 platform. 

5. You should see Navigator window in your MetaTrader platform on the middle left with Arbitron EA (if 

you don’t see it please click the + sign next to Expert Advisors): 

 
 

 

 

 

 

 

 

 

 

 



Sharing This Manual or Its Accompanying Software Without Permission Is Strictly Prohibited. 
LeapFX © Copyright 2019, All Rights Reserved. 

 

6. Now we need to open the windows within Meta Trader 4 for the currency pairs that Arbitron will be 

trading on.  To do this click the File button at the top left, then click on New Chart, then you will look for 

each of the following currency pairs listed and click them to open:  AUDUSD, EURUSD, EURJPY, 

GBPUSD, NZDUSD, USDCHF, USDJPY 

 

For each chart click on “M1” button toward the top to adjust the timeframe of that chart. This means 

each candlestick bar on the chart represents a minute.  

 

7. For each chart window you opened you will need to drag and drop the Arbitron system onto them or 

you can right click the Arbitron name and choose “Attach to a chart” – it will attach to whichever chart 

you have in focus (you can switch between charts, by clicking the tabs on the bottom right that have the 

name of each currency pair (do this for each currency pair chart you open from step 6): 

 

 
 

Each time you attach the Arbitron system to a chart window a box will appear like the following below.. 

Click Common then make sure the check marks match the following (then click Inputs): 

 
Important: You need to do this for each chart windows we opened in the last step. 
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8. In this window, first click Load then choose LOW RISK (low risk if you want to keep account safer, 

returns will be lower) or HIGH RISK (high risk if you are willing to have less safety, but much bigger 

profit), then click OK.  Now, in the settings window enter your E-mail used to purchased, and enter your 

Receipt you used to activate the software in members area.   

If your broker uses a PairSuffix, for example it has a letter at the end of the name of the currency pair, 

then you need to enter that PairSuffix into the PairSuffix setting in the list.  For example:  EURUSDc  the 

PairSuffix would be c 

Once done, click OK in the window. 

 
 

9. If everything is OK and loaded properly you will see the following on each currency pair chart and a 

smiley emoticon on the top right (you must attach Arbitron to each currency pair chart described 

earlier): 

 

 

Here is how to understand the numbers and boxes on the chart for your reference:  

• “F” - Feeder status – This is the connection between the Arbitron Feeder and the Arbitron system 

in Meta Trader 4.  If it’s green then the data streaming is stable, if there are any issues it 

becomes red. 

• “T” - Trading time – it will be green if the current MetaTrader4 server time is set properly within 

the software. If not – it becomes red. 

• Grey box - Next order size – The next trades that open, this will be the lot size used. 

• Last order open time – This is the time of opening last order for this instrument (in milliseconds)  

• Last order close time – This is the time of closing last order for this instrument (in milliseconds) 

 

If there is no smiley on the top right:  – check all the settings again.  It must be happy to work. 

 

10.  That’s it. Configuration is finished!  Let it run on its own 24/7. 
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Expert Advisor settings 

The following is a description of all the settings.  You shouldn’t have to edit them other than what was 

discussed, but for the more advanced user this is for your reference. 

 

LICENSE 

 

E-mail – Your email address used at purchase. 

Receipt – Your receipt you received after purchase (check email or spam folder). 

 

PRICING 

 

FeederSymbol – indicates symbol in Arbitron feeder to pick up quotes from, e.g. your MT broker has 

“EURO/DOLLAR” trading instrument, indicate here EURUSD 

FeederMarkupASK – this parameter helps adapt Arbitron feeder ASK price level to your MT broker’s 

price in manual mode, you indicate price correction in points. Please find the level of correction during 

normal market conditions 

FeederMarkupBID – this parameter helps adapt Arbitron feeder BID price level to your MT broker’s 

price in manual mode, you indicate price correction in points. Please find the level of correction during 

normal market conditions 

FeederAutoShift – calculate Arbitron feeder price level correction automatically 

FeederAutoShiftPeriod – number of price ticks to calculate level of price correction, bigger the figure – 

more accurate the price correction is 

FourDigitsBroker – set true if quotes of your broker have 4 digits after period (most brokers don’t use 

four digits anymore). 

BrokerPrefix – indicate here special symbols before standard instrument mask, e.g. you MT broker has 

aEURUSD instrument – set “a” for this parameter 

BrokerSuffix – indicate here special symbols after standard instrument mask, e.g. you MT broker has 

EURUSDc instrument – set “c” for this parameter 

BrokerMaxSpread – set in points the level of spread in MT terminal to open new positions, if exceeded 

– it will block new trades during that time. 

 

TRADING 

 

TriggerBuy – positive difference between your broker’s ASK price and Arbitron feeder’s BID price to 

open BUY position, e.g. if you set 30 and your broker’s current ASK price is 1.11000 – the minimum level 

of Arbitron feeder’s BID price to open BUY position should be 1.11030 
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TriggerSell – positive difference between your broker’s BID price and Arbitron feeder’s ASK price to 

open SELL position, e.g. if you set 30 and your broker’s current BID price is 1.11000 – the maximum level 

of Arbitron feeder’s ASK price to open SELL position should be 1.10970 

Lot – manually set volume for opening new orders 

UseDynamicLot – set true to calculate volume of new orders depending on your current balance 

DynamicLotPercent – determine risk of dynamic lot calculation using this formula: DynamicLot = 

(DynamicLotPercent*0.01*AccountEquity*AccountLeverage)/100000 

TimeBeforeNewOrderMs – you can set any pause in milliseconds (1sec=1000ms) between confirmation 

for opening N position and checking if signal for new trade still exist 

OrderLifeTimeInSeconds –  time in seconds for maintaining a position, if time is out – position will be 

closed  

BuyPositionsQuantity – maximum quantity of opened buy positions at one moment of time  

SellPositionsQuantity – maximum quantity of opened sell positions at one moment of time 

TPVirtual – virtual take profit indicated in points 

BreakevenStart – indicated in points level of profit to set BreakevenLevel  

BreakevenLevel – virtual SL level to close the position, value should be less than BreakevenStart, e.g. 

BreakevenStart is 10, BreakevenLevel is 5, position for BUY is opened at 1.11000. When BID price 

become equal or higher than 1.11010 BreakevenLevel will be set to 1.11005 

TrailingDistance – setting the distance in points from current price to pull up a virtual SL, e.g. 

TrailingDistance is 50, position for BUY is opened at 1.11000. When BID price become equal or higher 

than 1.11050 trailing will be activated  and virtual SL will be set to 1.11000, further price rising moves 

virtual SL higher at a Trailing Distance from current price 

SLVirtual – virtual stop loss indicated in points  

UseRealSL – set to true if you prefer real SL, we strongly recommend usage of virtual SL. Real SL may be 

used with ECN accounts without freeze levels 

Slippage – tolerance negative difference in points between order price and execution price for your 

order. For correct work of this function please set the same value in MT terminal settings 

(Tools>Options>Trade>Deviation by default>Default>THE SAME FIGURE, pips in MT terminal settings 

means points>OK). This parameter takes into consideration by broker only for instant execution 

DynamicSlippage – set true if you want calculate individual slippage for each arbitrage situation using 

formula: TriggerBuy/Sell - slippage, e.g. TriggerBuy is 140, Slippage is 10. Then our calculated 

DynamicSlippage = 140 – 10 =130 

StartTradingTime – set time for Arbitron expert to start trading at hh:mm:ss 

StopTradingTime – set time for Arbitron expert to stop trading at hh:mm:ss 
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OTHER 

 

ExpertMagic – unique number for your position, we recommend use 0, only EA (expert Arbitron) and 

your broker can see this number. Use magics only if you want other EAs pick up Arbitron’s orders 

ExpertComment – you can set any comment for positions to identify deals of Arbitron, but we don’t 

recommend use comments. It makes easier to find you and your deals in orders database 

SendDisconnectPush – set true to receive notifications on your mobile phone MT terminal if your broker 

had an issue with connection. In case of such situation you will see such status of Arbitron’s indicators: 

  you should restart your MT platform to recover working mode of Arbitron. Such measure 

helps avoid money loss in case of any technical issues on your broker side. To get notifications please 

configure your MT platform using this guide: https://www.metatrader4.com/en/trading-

platform/help/setup/settings_notifications 

SendTradePush – set true to receive notifications on your mobile phone MT terminal if any trading 

situation appears 

ShowLines – set true to indicate on graph Arbitron’s ASK and BID price levels for current instrument. 

Please turn off lines in order to save computing power of your VPS server   

LinesUpdatePeriodMS – using this parameter you can set update interval for Arbitron’s ASK and BID 

price levels. We recommend 1000+ ms to avoid overload of your VPS  

ColorAsk – choose color of Arbitron’s ASK price level 

ColorBid – choose color of Arbitron’s BID price level 

MetaTrader error codes 

You can find description of all possible MetaTrader platform errors here: 
https://book.mql4.com/appendix/errors 

 

https://www.metatrader4.com/en/trading-platform/help/setup/settings_notifications
https://www.metatrader4.com/en/trading-platform/help/setup/settings_notifications
https://book.mql4.com/appendix/errors

